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Where to find more information
Use the online Help for in-depth information not included in this Quick Start Guide. 

Display online help by pressing the F1 key to get more information about a 
window, tab, or dialog box.



What is MassHunter Optimizer?
Where to find more information
What is MassHunter Optimizer?

Automated MS 
Method 

Development 
Software

MassHunter Optimizer lets you automatically optimize the data acquisition 
parameters for MRM mode (multiple-reaction monitoring) for each individual 
compound analyzed. Specifically, it automates the selection of the best 
precursor ions, the optimization of the fragmentor voltage for each precursor ion, 
selection of the best product ions, and optimization of collision energy values for 
each transition for a list of compounds you specify.

Automated 
Optimization

Automation of the following optimization tasks results in a significant time 
saving over manual optimization procedures:

• Optimization of fragmentor voltage to maximize precursor ion intensity

• Selection of multiple best product ions (MS/MS full scan) 

• Optimization of collision energy to maximize product ion intensity (MS/MS full 
scan)

• Optionally perform fine fragmentor optimization for maximum sensitivity.

• Results Review shows you a graphical representation of the optimization 
results, allowing you to select the optimum fragmentor voltage and collision 
energy for selected product ions.

Additional 
Features

• Stores optimum precursor ion, product ions, and parameters in a compound 
database.

• Imports optimization results into the Agilent MassHunter Acquisition for 
Ultivo LC/TQ program.

• Lets you import compounds for optimization and update compound retention 
times from Data Acquisition methods

• Supports sample introduction via manual infusion (syringe pump), direct 
injection (via loop injection at lower flows), and injection analysis with column 
(to maximize optimization yield).

• Data that is acquired during the optimization run can be displayed with Agilent 
MassHunter Qualitative Analysis program.

You can optimize source parameters using the Agilent Source Optimizer 
program. For more information, see the online Help and the Familiarization Guide 
for the MassHunter Acquisition program.

NOTE
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Startup
To open Optimizer
Startup

MassHunter Optimizer is automatically installed with the MassHunter 
Acquisition program. 

To open Optimizer
You must first start the MassHunter Acquisition program before opening the 
MassHunter Optimizer program.

Open MassHunter Optimizer in one of the following ways:

• Double-click the Optimizer icon on the desktop, or

• Click the Windows icon and then click Agilent > Optimizer.
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User Interface
To open Optimizer
User Interface

The MassHunter Optimizer has the following user interface elements that let you 
enter parameters, set options, view status, and perform functions:

• “Menus and Toolbar” on page 5

• “Status Bar” on page 7

Tabs

• “Optimizer Setup Tab” on page 7

• “Precursor Ion Selection Tab” on page 7

• “Product Ion Selection Tab” on page 8

• “Compound Setup Tab” on page 8

Other Windows and Dialog Boxes

• “Compound Browser Window” on page 8
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User Interface
Menus and Toolbar
Menus and Toolbar
The following menu items and toolbar buttons are available in MassHunter 
Optimizer main window.

File menu

New Project Clears the current settings and lets you set up a new project for 
use in MassHunter Optimizer. See “To create a project” on page 11.

Open Project Lets you open a project. See “To open a project” on page 11.

Save Project Lets you save changes to the current project.

Save As Project Lets you save the current project under a new name.

Save Compounds Lets you save compound information to a database, for use 
with other projects. See “To save a database in Compound Browser” on 
page 28.

Delete Project(s) Lets you select projects and remove them.

Open Database Lets you open a different database. The newly opened 
database becomes the default database.

Exit Closes the MassHunter Optimizer window.

Edit menu

Copy Copies the selected rows, which can then be pasted into another position 
in the table. 

Cut Cuts the selected rows from the table, which can then be pasted into 
another position in the table. 

Paste Pastes the most recently copied or cut rows into the selected position in 
the table. 

Delete Removes the selected rows from the table

Select All Selects all rows in the table.
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User Interface
Menus and Toolbar
Fill Copies the value in the top cell down to the rest of the cells of a highlighted 
block or to the entire column. 

Clear  Lets you clear all fragmentor values, all collision energy values, or all 
results, including methods and all precursor and product ions for all compounds 
in the selected row and below in the table.

View menu

Show/Hide Columns Lets you select which columns of information to display 
in the table. At least one column in every row must be displayed.

Expand/Collapse All Rows Lets you display all rows in the table or collapse 
the table to show only Compound rows. This affects the currently selected row 
and all rows below it in the table.

Import/Export menu

Import from Database  Opens Compound Browser, which lets you select 
compounds for optimization from the database. See “Compound Browser 
Window” on page 8.

Import from Excel  Lets you import compounds from an Excel file. See “To 
import compounds from an Excel file” on page 20.

Import from Acquisition Methods Lets you import all compounds from 
Acquisition methods into the current project.

Export to Excel  Lets you export the current compound list for use in Excel. 
See “To export compound information to an Excel file” on page 21.

Optimization menu

Start Optimization  Starts the optimization process with the current 
parameters. The results are saved to the database and displayed in the 
Compound Setup tab. A report is automatically printed on completion. See “To 
start optimization” on page 30

Stop Optimization  Lets you terminate optimization before completion.

Generate Report Displays optimization results in PDF format. 
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User Interface
Status Bar
Tools menu

Update RTs Lets you update compound retention times from Data Acquisition 
methods. See “To update retention times from a MassHunter Acquisition 
method” on page 22.

Review Results Opens the Review Results window.

Help menu

Help Topics Opens the online help window with the Contents tab displayed.

About Optimizer Displays version information for Optimizer.

Status Bar
The following items appear in the status bar at the bottom of Optimizer main 
window: Database, Project Name, Optimizer Status, Current Record progress bar, 
and All Records progress bar.

Optimizer Setup Tab
Lets you set the acquisition parameters used for optimization, including sample 
introduction method, Acquisition methods, and ranges for optimization of 
fragmentor and collision energy voltages. See “To set Optimizer acquisition 
parameters” on page 13.

Precursor Ion Selection Tab
Lets you select ion species to include in the search for precursor ions. The 
default is +H for positive and -H for negative. See “To select precursor ions” on 
page 14.
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User Interface
Product Ion Selection Tab
Product Ion Selection Tab
Lets you set criteria to use in the search for product ions. See “To select product 
ions” on page 15.

Compound Setup Tab
Displays the list of compounds to optimize, and lets you enter precursor and 
product ion values, if known. You can also set different injection volumes for 
each compound to use for optimization, if needed. It also displays the results of 
optimization, when you mark the Show results summary check box. 

Compound Browser Window
This window appears when you click the Import from Database toolbar button. It 
lets you select compounds for optimization from the database. The selected 
compounds are added to the Compound Setup tab. See “To import compounds 
from a database” on page 24.

Compound Browser also lets you open a different database, save the current 
database with a new name, and make the current database the default database.
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Getting Started
Compound Browser Window
Getting Started

This figure shows the general workflow to use Optimizer.

Step 1
Set up LC/MS

• Prepare sample with a concentration around 1 ng/µL.
• Prepare a suitable mobile phase.
• Use either a short column or length of tubing.

(5042-6462 PEEK Tubing 1/16 inch, 0.007/0.18 mm ID, 5 m). 
• Use a generic gradient with 5% to 75% organic.
• Acquire data in Scan mode, check for ions of interest, run in  SIM mode 

to confirm precursor ions, and save SIM method.

Step 2
Set up project
in Optimizer

Step 3
Start Optimizer

• Create a Project in Optimizer.
• Follow the setup described in this guide.
• Select the SIM method from Step 1 (this ensures that Optimizer will use 

the LC and source conditions from Step 1).

• Optimizer automatically runs four separate acquisitions for
each target ion in the sequence:

• SIM > Product Ion > MRM > Product Ion
• Review the report that provides you with the optimized MS conditions 

for the target ions
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Getting Started
Compound Browser Window
When Optimizer starts, it automatically proceeds through the following scan 
types, in the order shown, for each precursor listed in the Compound Setup table.

Refer to the steps in the rest of this guide for detailed instructions on how to use 
Optimizer.

SIM

Product
Ion

MRM

Product
Ion

Sets the Scan type to SIM for each precursor 
and acquires the data to optimize the 
Fragmentor voltage for each precursor.

Sets the Scan type to Product Ion and 
acquires the data to find product ions for each 
precursor.

Sets the Scan type to MRM on the Product 
Ions found in the previous step and acquires 
the data to optimize Collision Energy.

Validates the optimal Collision Energy and 
masses using a smaller scan range for 
Product Ions.
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Using Projects
To create a project
Using Projects

• “To create a project” on page 11

• “To open a project” on page 11

• “To edit a project” on page 12

• “To save parameters to the current project” on page 12

• “To save parameters to a new project” on page 12

To create a project
Use this procedure to store all the values and settings used for optimization in a 
project.

1 Click the New Project button on the toolbar.

If current parameters have not already been saved, you are prompted to save 
the project. The current parameters are cleared.

2 Make the desired changes to parameters on the following tabs:

• Optimizer Setup tab

• Precursor Ion Selection tab and Product Ion Selection tab

• Compound Setup tab

3 Click the Save Project or Save As Project button and enter a name for the 
project.

To open a project
Use this procedure to use optimization values and settings from an existing 
project.

1 Click the Open Project button on the toolbar.

2 Click to select the project on the Select Project Name dialog box.

3 Click the Open button.
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Using Projects
To edit a project
To edit a project
1 Open the project to edit as described above.

2 Make the desired changes to parameters on the following tabs:

• Optimizer Setup tab

• Precursor Ion Selection tab

• Product Ion Selection tab

• Compound Setup tab

3 Save the parameters. See “To save parameters to the current project” on 
page 12 or “To save parameters to a new project” on page 12.

To save parameters to the current project
1 Click the Save Project toolbar button.

To save parameters to a new project
1 Click the Save As Project toolbar button.

2 Enter a name for the project and click the Save button.
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Setting Optimization Parameters
To set Optimizer acquisition parameters
Setting Optimization Parameters

Use the following procedures to set up the optimization parameters for 
MassHunter Optimizer.

“To set Optimizer acquisition parameters” on page 13

“To select data path and methods to use for optimization” on page 14

“To select precursor ions” on page 14 

“To select product ions” on page 15

To set Optimizer acquisition parameters
1 Click the Optimizer Setup tab.

2 Set the desired Sample introduction method (Injection, Automatic infusion, 
or Manual infusion).

3  Set the Fragmentor ramp parameters as follows:

a Set the range for ramping the Fragmentor values.

b (optional) Mark the Fragmentor Fine check box and enter a Step size for 
Fine ramping. Fine optimization refines the coarse ramping values and 
provides better optimization but takes longer to run.

4 Set the range for ramping the Collision Energy values.

5 Continue to select data path and methods to use for optimization as 
described below.
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Setting Optimization Parameters
To select data path and methods to use for optimization
To select data path and methods to use for optimization
1 If not already displayed, click the Optimizer Setup tab.

2 Select a Path for data files to store the optimization run data. The data can be 
displayed later with the MassHunter Qualitative Analysis program.

3 In the table on the right side of the tab, select the acquisition methods with the 
appropriate LC and source parameters to use for optimization.

a Right-click the table and click Add Method from the shortcut menu. This 
adds a row to the end of the table for a new method.

b Click the button on the right side of the Acq Method cell to open the Select 
Method dialog box.

c Select the method of interest and click Open. The Polarity and Ion Source 
will be filled in from the values set in the selected method.

d Check to make sure that the Ion Source from the method matches the 
physical configuration of your instrument.

e (optional) Repeat step a through step d to select additional methods for 
optimization. 

Tip Additional options are available by right-clicking the method table, such as 
Delete Methods, Copy, and Fill.

To select precursor ions
Use this procedure to specify precursor ions to use to optimize the fragmentor 
voltage. The information entered here will be used for all compounds, except for 
those that have precursor ions specified on the Compound Setup tab.

1 Click the Precursor Ion Selection tab.

2 Select the Positive and Negative adduct ions to include.

If necessary, add Positive or Negative adduct ions to the list by typing the 
value in the box and clicking the  button.

3 To exclude certain masses from consideration, click Exclude masses at the 
bottom of the screen. Enter the m/z values to exclude separated by commas 
and/or enter a Minimum abundance value in counts.
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Setting Optimization Parameters
To select product ions
To select product ions
Use this procedure to specify product ions to use to optimize the collision energy 
voltage. The information entered here will be used for all compounds, except for 
those that have product ions specified on the Compound Setup tab.

1 Click the Product Ion Selection tab.

2 Enter the Maximum number of product ions to find during the product ion 
scan phase. 

• For Triggered MRM applications, the recommended value is 10. 

• For MRM and Dynamic MRM applications, the recommended value is 4.

3 Enter a Low mass cut-off value. Select whether to specify the value as Mass 
(m/z) or as a % Precursor mass (m/z) and enter the cut-off value.

4 To exclude certain masses from consideration, click the Exclude masses 
option at the bottom of the screen. Enter the m/z value(s) to exclude 
separated by commas and/or enter a Minimum abundance value in counts.

5 If desired, you can also enter Neutral Losses to exclude, for example water 
(H2O). Enter a formula in the box, and click the button to add it to the list.
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Setting Up Compounds in Optimizer Window
To select product ions
Setting Up Compounds in Optimizer Window

Use the following procedures to set up compounds for use in MassHunter 
Optimizer.

Setting up compounds

• “To set up a compound list” on page 17

• “To use known ions for individual compounds” on page 19

Using compound databases

• “To open a database in Optimizer Window” on page 20

• “To save compounds to a database” on page 20

Importing and exporting compound information from Excel

• “To import compounds from an Excel file” on page 20

• “To export compound information to an Excel file” on page 21

Using compound information from MassHunter Acquisition methods

• “To import compounds from a MassHunter Acquisition method” on 
page 21

• “To update retention times from a MassHunter Acquisition method” on 
page 22
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Setting Up Compounds in Optimizer Window
To set up a compound list
To set up a compound list
Use this procedure to set up the list of compounds to optimize and enter 
precursor and product ion values, if known.

1 Click the Compound Setup tab.

2 (optional) Import compounds as described in “To import compounds from an 
Excel file” on page 20 or “To import compounds from a database” on 
page 24. 

3 Clear the Show results summary check box above the table while you set up 
the compound list.

4 To add a compound:

a Right-click the table and click Add Compound from the shortcut menu to 
add a row to the end of the table.

b Enter the Compound Name for the new compound.

c (optional) If you want to be able to find groups of compounds in the 
database such as sulfa drugs or pesticides, assign a group name in the 
Groups column. You can then specify the desired group names when you 
filter compounds to import from the database as described on page 24.

d Enter the Formula of the compound. The Mass will be automatically 
calculated from the formula. If you don’t know the formula, then enter the 
monoisotopic mass in the Mass column.

e Enter the Sample Position (physical location in the autosampler) for the 
new compound.

f To use the injection volume set in the Optimization method for 
optimization, for Set Inj Vol, select asMethod. To set a specific injection 
volume for this compound, for Set Inj Vol, select Specified Value. Enter the 
desired injection volume in the Inj Vol column and the Product Ion Scan 
Injection Factor value in the PI Scan Inj Factor column. Note that the 
injection volume for the Phase 2 – Product Ion Scan optimization step is 
determined by multiplying the Inj Vol by the PI Scan Inj Factor. 

g (optional) Adjust the Optimization dwell time value to set a shorter or 
longer cycle time if desired; otherwise, a default value is used.

h (optional) To speed up optimization, specify precursor and product ions for 
the compound as described in “To use known ions for individual 
compounds” below. If no methods or ions are specified here, then 
optimization for the compound uses the methods from the Optimizer 
Setup tab and information from the Precursor Ion Selection and Product 
Ion Selection tabs to generate the ions.
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Setting Up Compounds in Optimizer Window
To set up a compound list
i Repeat the steps above to add more compounds to the table. 

Compounds are global to all projects. Compound information such as name, 
group, formula, and mass in one project will be reflected in the entire database. 

Tip To cut or copy and paste compounds (rows) in the table:

a Select the rows of interest in the table.

b Right-click the selected rows and click Cut or Copy from the shortcut 
menu.

c Right-click the new location for the cut or copied rows and click Paste from 
the shortcut menu.

5 Mark the Select columns for the compounds (rows) to use for optimization.

6 Save the compound list as described in “To save a database in Compound 
Browser” on page 28 or “To save parameters to the current project” on 
page 12.

7 (optional) Export the compound list as described in “To export compound 
information to an Excel file” on page 21.

NOTE
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Setting Up Compounds in Optimizer Window
To use known ions for individual compounds
To use known ions for individual compounds
Use this procedure to optionally specify methods, precursor ions, and product 
ions for individual compounds on the Compound Setup tab. Using known ions 
speeds up the optimization process.

1 Add compounds to the Compound List as described in “To set up a 
compound list” on page 17.

2 To add methods for the current compound:

a Right-click the Compound row of interest and click Add Method from the 
shortcut menu. This adds a Method row below the selected compound.

b Click the down arrow button on the right end of the Acq Method cell and 
select an acquisition method to use for the selected compound. 
If you don’t see the method of interest, add it to the Method Table on the 
Optimizer Setup tab as described in “To set Optimizer acquisition 
parameters” on page 13.

c Repeat the above steps to add more methods for the current compound.

3 To specify a known precursor ion for the current compound:

a Right-click the Method row for the compound of interest and click Add 
Precursor Ion from the shortcut menu. This adds a Precursor Ion row for 
the current compound. 

b Enter a value for the Precursor Ion. 

4 To specify product ions for the current compound:

a Right-click the Precursor Ion row for the compound of interest and click 
Add Product Ion from the shortcut menu. This adds a Product Ion row for 
the current compound. 

b Enter a value for the Product Ion.

c Repeat the above steps to add the product ions for the current compound 
and precursor ion.

5 Repeat step 2 through step 4 to specify methods and ions for other 
compounds in the Compound Table.
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Setting Up Compounds in Optimizer Window
To open a database in Optimizer Window
To open a database in Optimizer Window
Use this procedure when you want to use a database other than the default 
Optimizer database.

1 In the Optimizer Window, click File > Open Database.

2 Select the database of interest and click OK.

When you open an Optimizer database, it becomes the default database. Any 
work done in Optimizer is saved to that database.

If you are building a unique database, open the database in Compound Browser, 
rename it with a unique name, and then save it as the default. As you build 
projects in Optimizer in this new database, you save those compounds to that 
uniquely named database.

To save compounds to a database
• To save compounds to the current database, click the Save Compounds 

button on the main toolbar.

Changes made to transitions and triggers are saved with the database.

You can import the compounds into other projects at a later time as described 
in “To import compounds from a database” on page 24.

To import compounds from an Excel file
1 Click the Import from Excel button on the main toolbar.

2 Select the .xls, .xlsx, or .csv file to import, and then click Open. All compounds 
from the file will be imported and listed on the Compound Setup tab.

The Select Method for Linking Compounds dialog box may be displayed to 
assign methods to the compounds.
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Setting Up Compounds in Optimizer Window
To export compound information to an Excel file
To export compound information to an Excel file
1 Click the Export to Excel button on the main toolbar.

2 Enter a name to export the compound list in .xls format for use in Excel, and 
click Save.

To import compounds from a MassHunter Acquisition 
method

1 Create MassHunter Acquisition methods for the compounds you want to 
import.

2 Click the Import from Acquisition Methods toolbar button in Optimizer.

3 Select the MassHunter Acquisition methods from step 1 that contain the 
compounds of interest, and then click the Open button.

All compounds in the data acquisition methods will be added to the current 
project and can be seen on the Compound Setup tab.
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Setting Up Compounds in Optimizer Window
To update retention times from a MassHunter Acquisition method
To update retention times from a MassHunter Acquisition 
method

1 Create MassHunter Acquisition methods for the compounds of interest.

2 Be sure that compounds whose retention times you want to update are part of 
a project. Only retention times for compounds that are part of a project will be 
updated. Retention times for compounds that are not in a project will not be 
updated, even if those compounds are in the database.

3 Click the Update RTs button on the Optimizer main toolbar.

4 Select the MassHunter Acquisition methods from step 1 that contain the 
compounds of interest, and then click the Open button. 

5 When the Update Retention Time Options dialog box appears:

a Select whether to Update in current project or to Search database for 
eligible projects.

b To update retention time windows, mark the Update RT Windows check 
box. If marked, the retention time windows in the acquisition method will 
be used to update the retention time windows in the database.

c If transition ions are found that do not match existing transition ions, you 
can add them by marking the Add new transitions found check box. 
Otherwise these transitions will be ignored.

d Click OK.

6 Several scenarios may result:

Projects are found that contain the same methods and transition ions In 
this case, select the project to update, and click OK.

or

No project matches for update In this case, you are prompted to select 
whether to add the transition ions to the Current Project or a New Project. 
Click the desired option, and then click OK.

All transition ions of the same compound will be updated with the first 
retention time in the acquisition method. The updated compound information 
can be seen on the Compound Setup tab.

7 Be sure to save the project to save the updated retention times.
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Using Compound Browser
To open a database and make it the default database
Using Compound Browser

Use these procedures to work with Compound Browser.

• “To open a database and make it the default database” on page 23

• “To import compounds from a database” on page 24

• “To select transitions and triggers for Dynamic and Triggered MRM” on 
page 26

• “To save a database in Compound Browser” on page 28

• “To filter compounds in Compound Browser” on page 28

• “To search compounds in Compound Browser” on page 29

To open a database and make it the default database
Use this procedure when you want to use a database other than the default 
optimizer database.

1 If Compound Browser is not already open, click the Import from Database 
button on the Optimizer window toolbar to open it.

2 Click the Open Database button on the Compound Browser toolbar. You 
instead can click File > Open Database.

3 Select the database of interest and click OK.

4 You are asked if you want to make this database the default database.

If you are importing additional compounds into an existing project, click No. 
Otherwise, unsaved changes made to the current project will be lost. All saved 
compound information in the previous project will still exist in the previous 
default database, but it won't be available for use with the new default database.

Tip

If you decide later to make this database the default database, click the Set 
Default Database button on the Compound Browser toolbar. You can instead 
click File > Set Default Database.

NOTE
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Using Compound Browser
To import compounds from a database
To import compounds from a database
Use this procedure to import compounds that have previously been saved as 
described in “To save a database in Compound Browser” on page 28.

1 Click the Import from Database toolbar button in the Optimizer window to 
open Compound Browser.

2 If not already open, open the database of interest as described on page 23.

3 Select compounds for optimization from the database.

• If desired, filter compounds as described on page 28.

• If desired, search compounds as described on page 29.

• To display all compounds in the database, mark the Show All Records 
check box.

4 When the compounds from step 3 appear in the Compound table in the lower 
half of Compound Browser, select the transition ions to import in one of the 
following ways:

• Individually mark the check boxes in the first column of the table for the 
transition ions you want to import.

• Click the Select top ranked transitions option, enter the number of top 
transitions to import for each compound, and then click the Select 
Transitions button. You can rank the top transitions by either Abundance 
or Response Factor.

• To select the primary transitions, click the Primary Transitions option, and 
then click the Select Transitions button.

• To select the secondary transitions, click the Secondary Transitions 
option, and then click the Select Transitions button.

To set up the primary and trigger transition ions to import, see “To select 
transitions and triggers for Dynamic and Triggered MRM” on page 26.

5 Do one of the following:

• If the compounds in the table are the only ones you want to import at this 
time, click Import. This closes Compound Browser and adds the 
compounds to the Compound Setup tab.

• If you want to do additional search and filter operations on the current 
database or a different database, click Add to Import List.

6 Do one of the following:

NOTE
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Using Compound Browser
To import compounds from a database
• To find more compounds in the same database, repeat step 3 through 
step 5.

• To select compounds from a different database, repeat step 2 through 
step 5.

7 Click the Import List tab to review the list of compounds. 

• Right-click and click Remove from the shortcut menu to remove any 
compounds you don’t want to import.

8 Click the Import button.

The imported compounds will appear on the Compound Setup tab.
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Using Compound Browser
To select transitions and triggers for Dynamic and Triggered MRM
To select transitions and triggers for Dynamic and 
Triggered MRM

1 If not already open, open the database of interest as described on page 23.

2 In Compound Browser, display compounds for optimization from the 
database.

• If desired, filter compounds as described on page 28.

• If desired, search compounds as described on page 29.

• To display all compounds in the database, mark the Show All Records 
check box.

3 For any unwanted compound, clear the check box next to the Compound 
Name in the first column of the Compound table.

Triggered 
MRM method 

(tMRM)

4 Select transitions for a triggered MRM method as follows:

a In the Select top ranked transitions field, enter the maximum number of 
transitions per compound that you want to show in the import list. You can 
have two primary transitions, plus additional secondary transitions (see 
step c below).

b Click the Select Transitions button to display the transitions in the 
Compound table. 

c In the Set primary and trigger flags area, specify the number of Primary 
transitions to use. The rest are assigned as Secondaries. Typically, two 
primaries are used. 

d Click Set Primaries and Trigger. The most abundant transition is 
automatically assigned as the Trigger.

e Review the compound list and edit as needed.

• A very abundant low m/z ion may be unsuitable as a Primary transition. 

• You can manually select a different transition for a compound as the 
Primary transition, and define a low m/z ion as a Secondary. 

• You may want to select two Primaries as triggers for a compound.

Dynamic MRM 
method 
(dMRM)

5 Select transitions for a dynamic MRM method as follows:

a Click Primary transitions. 

b Click the Select Transitions button to display the transitions in the 
Compound table. 

• At this point, all transitions are displayed as primaries.

• Typically, the transitions are ranked by abundance.
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Using Compound Browser
To select transitions and triggers for Dynamic and Triggered MRM
c Review the compound list and edit as needed.

• Clear any unwanted transitions.

6 When the list of transitions is set, click the Add to Import List button below 
the Compound table.

7 Do one of the following:

• To find more compounds in the same database, repeat step 2 through 
step 6.

• To select compounds from a different database, repeat step 1 through 
step 6.

8 Click the Import List tab to review the list of compounds. 

• Right-click and click Remove in the shortcut menu to remove any 
compounds you do not want to import.

9 Click the Import button.

The imported compounds will appear on the Compound Setup tab.
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To save a database in Compound Browser
To save a database in Compound Browser
Do one of the following to save compounds to a database:

• To save compounds to the current database, click the Save Database 
button on the Compound Browser toolbar.

• To save compounds to a new database, click the Save As Database 
button on the Compound Browser toolbar. When prompted, enter a 
name for the new database, and click Save.

Changes made to transitions and triggers in Compound Browser are not saved 
with the database.

Once saved, you can import the compounds into other projects at a later time.

To filter compounds in Compound Browser
1 If not already open, open the database of interest as described on page 23.

2 Enter the Filter criteria in the upper left area of the Compound Browser 
Search/Filter tab. Note that filter criteria are unavailable if Show All Records 
is selected.

• Mark the Enable Filters check box.

• Mark the check boxes for the filter criteria to use, such as Optimized 
Compounds, Date, Group Name, Project Name, Polarity, Model, and 
Method. Enter values for each selected criteria.

3 Click the Search/Filter button.

The compounds that pass the filter are displayed in the Compound table in 
the lower part of the screen.

NOTE
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To search compounds in Compound Browser
To search compounds in Compound Browser
1 If not already open, open the database of interest as described on page 23.

2 Clear the Show All Records check box.

3 Enter the Search Text in the upper right area of the Compound Browser 
Search/Filter tab, such as Compound Name and Formula. This can be either a 
partial or complete entry as described in step 5.

The best parameter to use in a search is the CAS number or the formula as 
you have specified. You will not get a match if you misspell the name or if the 
name is spelled differently in the database.

The values you enter here for Product or Precursor ions are treated as numeric 
values rather than text. Matches are returned whose values fall between 0.7 
amu below the entered mass and 0.3 amu above the specified mass.

4 Mark the columns to search or click the top entry in the list (Select Columns) 
to search all columns.

5 Do one of the following: 

• To find compounds that match only a partial name or formula, clear the 
Match entire word for each string check box. 

• To find only compounds that exactly match the text you entered in step 3, 
mark the Match entire word for each string check box. 

6 To ignore all filters for this search, clear the Enable filters check box.

If you want to display all items in the database, mark the Show All Records 
check box. This automatically disables all the search and filter options. 

7 Click the Search/Filter button. 

• The compounds that meet the search criteria are displayed in the 
Compound Table in the lower part of the screen. 

• Search text that was not found in the search is shown in red.

NOTE

NOTE
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To start optimization
Optimization and Results

Use the following procedures to run the optimization procedure, evaluate the 
results, and import them into the MassHunter Acquisition program.

“To start optimization” on page 30

“To review optimization results” on page 31 

“To manually set collision energy voltages” on page 31

“To import optimization results to Acquisition for dMRM/tMRM” on page 33

“To import optimization results to Acquisition for MRM time segments” on 
page 36

To start optimization
1 Set the optimization parameters as described on page 13.

2 Set up the compound list as described in “To set up a compound list” on 
page 17.

3 Start the optimization process:

• Click the Start Optimization button on the toolbar.

4 If necessary, you can stop the optimization process by clicking the Stop 
Optimization button on the toolbar.

5 Review results as described below.

6 (optional) Use the MassHunter Qualitative Analysis program to look at the 
data acquired during the optimization run.
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To review optimization results
To review optimization results
1 Run the optimization procedure as described above.

2 Click the Compound Setup tab.

3 Mark the Show results summary check box above the table.

4 Review the following values for each transition in the Compound table:

Fragmentor—The optimum voltage to apply to the exit end of the capillary for 
the compound, determined by MassHunter Optimizer.

Collision Energy—The optimum voltage to apply to the ions in the collision cell 
for the compound, determined by MassHunter Optimizer.

5 Click Optimization > Generate Report. 

6 Review the printed optimization report.

7 See “To import optimization results to Acquisition for MRM time 
segments” on page 36, to use optimization values for data acquisition.

To manually set collision energy voltages
1 Set optimization parameters and start optimization as described above.

2 Click Tools > Review Results. The Review Results dialog box opens. See 
Figure 1 on page 32.

3 Apply the selected value to either All ions or only the Selected ion by clicking 
the appropriate option for Apply manual selection to.

4 If desired, you can reload the collision energy values set by optimization at any 
time by clicking the Reset Collision Energy button or the Reset Fragmentor 
button. Doing this overwrites the manual selections you made above.

5 To save the results, click . The changes that you made are saved. You 
can see these changes in the Compound Setup tab in the fourth level of the 
table.

6 Click the X in the upper right corner to close the Review Results command.
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To manually set collision energy voltages
Figure 1 Review Results dialog box
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Optimization and Results
To import optimization results to Acquisition for dMRM/tMRM
To import optimization results to Acquisition for 
dMRM/tMRM

1 Display the Method Editor window in MassHunter Acquisition.

2 Create or open the method of interest. 

3 Click the QQQ tab in the Method Editor window.

4 Click the Acquisition tabsection in the left pane.

5 Select the time segment of interest or create a new one.

6 Set Scan type to  dMRM or tMRM as shown above.

7 For triggered MRM, mark the Triggered check box in the lower right area of 
the Acquisition tab.

8 Notice that additional columns are now available in the Scan segments table, 
including Primary, Trigger, Trigger Window, Trigger Threshold, Trigger 
Entrance, and Trigger Delay.

9 Use the expected retention time and RT window parameters to set the 
timetable for monitoring transitions. Usually only a single Time segment is 
used for dMRM and tMRM. Note that the Cycle time remains constant. 

• As transitions are added to the list in real time, the Dwell time is reduced 
for each transition that is active to keep the Cycle time constant. 

• The reverse happens for transitions whose time has elapsed, and dwell 
times are increased for the remaining active transitions. 

• For a single compound on the list, one transition serves as the quantitation 
response. Other transitions for the same compound are used as qualifiers. 

10 Click Compound Browser in the left pane.
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Optimization and Results
To import optimization results to Acquisition for dMRM/tMRM
11 When Compound Browser appears:

a If desired, filter the compounds as described on page 28.

b If desired, search compounds as described on page 29.

c Mark the transition ions of interest from the Compound table in the lower 
half of Compound Browser in one of the following ways:

• Manually select the transition ions you want to import for each compound, 
or 

• Enter the top number of transitions to import for each compound, and then 
click the Select button. You can select the top transitions based on either 
Abundance or Response Factor. Clear the check box for any transitions 
that you don’t want to use.

12 If the transition ions selected in the table are the only ones you want to import 
at this time, click Import. This closes the Compound Browser window and 
adds the transition ions into the current time segment.

• Otherwise, to do additional search and filter operations on the current 
database or a different database, click Add to Import List. 

13 To select additional compounds:

a To select compounds from a different database, open the database of 
interest as described on page 23.

When asked if you want to make this database the default database, click No. 
Otherwise, unsaved changes made to the current project will be lost. All saved 
compound information in the previous project will still exist in the previous 
default database, but won't be available for use with the new default database.

b Repeat step 11 to select the transition ions of interest.

c Click Add to Import List.

14 Click the Import List tab to review the list of transition ions. To remove any 
transition ions you don't want to import, right-click and click Remove from the 
shortcut menu.

15 Click the Import button. The selected transitions are imported into the current 
time segment.

NOTE
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Optimization and Results
To import optimization results to Acquisition for dMRM/tMRM
16 Review the timings to make sure that not too many transitions are being 
monitored concurrently. The graph in the Acquisition section shows how 
many transitions are concurrent.

When too many transitions are active at the same time, the dwell time per 
transition may become too short (1-2 msec per transition or less). Under these 
conditions, the signal/noise ratio is low, and the quantitation accuracy and 
precision may suffer. 

If necessary, change the retention time windows or delete transitions to 
increase the average dwell time. 

17 (optional) Save the method.

NOTE
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To import optimization results to Acquisition for MRM time segments
To import optimization results to Acquisition for MRM time 
segments

1 Display the Method Editor window in the MassHunter Acquisition program.

2 Create or open the method of interest. 

3 Click the QQQ tab in the Method Editor window.

4 Click the Acquisition section in the left pane.

5 Select the time segment of interest or create a new one.

6 Set Scan Type to MRM.

7 Click Compound Browser in the left pane.

8 When Compound Browser appears:

a If desired, filter the compounds as described on page 28.

b If desired, search compounds as described on page 29.

c Mark the transition ions of interest from the Compound table in the lower 
half of Compound Browser in one of the following ways:

• Manually select the transition ions you want to import for each compound, 
or 

• Enter the top number of transitions to import for each compound and click 
the Select button. You can select the top transitions based on either 
Abundance or Response Factor. Deselect any transitions that you don’t 
want to use by clearing their check box.

9 If the transition ions selected in the table are the only ones you want to import 
at this time, click Import. This closes the Compound Browser window and 
adds the transition ions into the current time segment.

• Otherwise, to do additional search and filter operations on the current 
database or a different database, click Add to Import List. 
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To import optimization results to Acquisition for MRM time segments
10 To select additional compounds:

a To select compounds from a different database, open the database of 
interest as described on page 23.

When asked if you want to make this database the default database, click No. 
Otherwise, unsaved changes made to the current project will be lost. All saved 
compound information in the previous project will still exist in the previous 
default database, but won't be available for use with the new default database.

• Repeat step 8 to select the transition ions of interest.

• Click Add to Import List.

b Click the Import List tab to review the list of transition ions. To remove any 
transition ions you don't want to import, right-click and select Remove
from the shortcut menu.

c Click the Import button. The selected transitions are imported into the 
current time segment.

11 Repeat step 5 through step 10 for each time segment of interest.

12 (optional) Save the method.

NOTE
Agilent MassHunter Optimizer for Ultivo LC/TQ Quick Start Guide 37



Agilent Technologies, Inc. 2017

Revision A, November 2017

*G3793-90009*

G3793-90009

www.agilent.com

In this guide

This Quick Start Guide describes how to use 
MassHunter Optimizer Automated MS Method 
Development software.

This guide is valid for the C.01.00 revision or 
higher of the Agilent MassHunter Optimizer  
software, until superseded.

http://www.agilent.com

	Where to find more information
	What is MassHunter Optimizer?
	Startup
	To open Optimizer

	User Interface
	Menus and Toolbar
	Status Bar
	Optimizer Setup Tab
	Precursor Ion Selection Tab
	Product Ion Selection Tab
	Compound Setup Tab
	Compound Browser Window

	Getting Started
	Using Projects
	To create a project
	To open a project
	To edit a project
	To save parameters to the current project
	To save parameters to a new project

	Setting Optimization Parameters
	To set Optimizer acquisition parameters
	To select data path and methods to use for optimization
	To select precursor ions
	To select product ions

	Setting Up Compounds in Optimizer Window
	To set up a compound list
	To use known ions for individual compounds
	To open a database in Optimizer Window
	To save compounds to a database
	To import compounds from an Excel file
	To export compound information to an Excel file
	To import compounds from a MassHunter Acquisition method
	To update retention times from a MassHunter Acquisition method

	Using Compound Browser
	To open a database and make it the default database
	To import compounds from a database
	To select transitions and triggers for Dynamic and Triggered MRM
	To save a database in Compound Browser
	To filter compounds in Compound Browser
	To search compounds in Compound Browser

	Optimization and Results
	To start optimization
	To review optimization results
	To manually set collision energy voltages
	To import optimization results to Acquisition for dMRM/tMRM
	To import optimization results to Acquisition for MRM time segments


